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Beyond accounting o

FnB Release Note 5.0.12.123

Bug Fixes:

ID Description

3828 Fix Item Package member promotion price doesn’t refresh issue.

4031 Fix member promotion with line discount (after update quantity line discount become null) issue.

4125 Fix wrong cash computation data in Close Counter Report issue.

4109 Fix when enable “Print Order No.” option after payment occur object reference error issue.

4119 Fix fast menu image blur issue.

4034 Fix Combine Bill issue.

4085 Fix Multi-Dimensional POS Analysis Report double click drill to source document issue.

4082 Fix Multi-Dimensional POS Analysis Report Profit Margin column data issue.

4043 Fix MyEG EIS setting in Configuration Setting disappear issue.

3737 Fix POS Sales Report issue when payment method is Point / Custom Payment / E-Wallet.

4144 Fix Stock Card open POS/F&B source document error prompt issue.

4266 Fix Qty decimal doesn’t reflect after sync and re-login front-end.

4312 Fix “Cancel Changes” access right issue.

4328 Fix Close Counter Report Payment & Item Summary data issue if have multiple sub-session.

4375 Fix POS Session and Close Counter Report “Pax No.” column incorrect data issue.

3988 Fix after create new account book, Access Rights for Administrators group is empty issue.

3940 Fix line discount amount calculation issue when tick “Calculate Discount On Unit Price” option and
items with promotion.

4029 Fix edited staff attendance sign in / out time at front-end wont sync back to HQ issue.

4449 Fix multiple levels Menu Design issue.

4265 Fix sync issue when account book is newly created and in other currency than MYR.

4534 Fix Design Menu Details add in new item error prompt issue.

3747 Fix Auto Screen Lock at Payment screen and Order screen issue.

4344 Fix Change Code for Project No. and Department No. issue.

4466 Fix Document Number format by date time issue.

4309 Fix POS Receipt report overwrite Accounting Invoice report due to having same report name
issue.

4432 Fix after change item to another UOM, barcode column doesn’t refresh issue.

4373 Fix missing Access Rights for Item Ingredient Listing Report.

4412 Fix Menu Design error prompts if description contain symbol.

4409 Fix migrate database from POS 3.1 to POS 5.0 will prompt error message "Column IsFnB does not
allow nulls" issue.

4553 Fix Export Master function will delete all the files from the selected export folder path issue.

4533 Fix “Set Remarks” shortcut button doesn’t show at function bar even already set issue.

4655 Fix Price History screen on-screen keyboard issue.
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Enhancement:

ID Description

4038 Add access right control for “Set Description”.

3915 POS Audit Trial support Below Minimum Selling Price event.
3950 Find Item function support find Item Package Barcode.

4303 Support get E-Wallet Type from AutoCount Server.

4174 POS Audit Trial support Refund / Trade In event.

4374 Support auto create front-end database and sync for standalone FnB.
4131 Support Clerk Menu function.

4297 Add EWallet Transaction ID column in EWallet Report.

3839 Auto Prompt function support prompt Description.
4310 Enhanced Customer Info prompts before payment.
3765 LCD Customer Display supports show Modifier, Item Package and Set Meal detail.

4535 Add “Clean Old ChangelLog” function.
4458 Support “Multi Pricing” for front-end member.

4041 Support download sample account book during create new back-end account book.

4453 Support load image from Stock Item Maintenance when add in new Fast Selection Menu Items.
4413 Support fingerprint at supervisor bypass screen.

4672 Support loads multiple item group and item type in Kitchen Printer Maintenance.

4645 Support Sales Credit Note in Remote HQ Function.

4679 Add in “Table No.” column in Kitchen Printer Log screen.
2650 Support Auto UOM Conversion.

4148 Support new dongle for front-end.

Microsoft .Net Framework Upgrade:
ID \ Description
4524 Upgrade .Net Framework from 4.5 to 4.6.1
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Highlights of Changes in 5.0.12.123

ID: 4038 Add access right control for “Set Description”
You can find “Change Description” access right under Data Entry.

=

User without this access right cannot use the Set Description function in frontend.

& Edit POS User Group x

User Group ID : Administrators

Description : Administrators Role

Maximum Discount : 100 %

‘ Search ‘ ‘ Expand All ‘ [ show Only Applied Direct Access Right
|Descriph'on Direct Access Right | |
(=} Paoint of Sales -

- Data Entry
: Change Price
Change LIOM

ange Description

Change Currency Rate
Delete Row
Row Discount

& E EyEpE E OO
i

Trtal Piermint

ID: 3915 POS Audit Trial support Below Minimum Selling Price event
POS Audit Trial report is now support audit trial for Below Minimum Selling Price.
You can find POS Audit Trial report under Point of Sale > Miscellaneous Reports > POS Audlit Trial.

= POS Audit Trail - POS TESTING BACKEND - AutoCount POS (Ver: 5.0) (Rev: 123) - B X

File G/L A/R A/P Inquiry Stock Sales Purchase BonusPoint Barcode Management Plug-Ins Point of Sale General Maintenance Tools Tax Window Help | Report

W

Keyword Search | ‘ Clear Search | | Close
Search Criteria
Description Event Message [ Computer Name
Filter Options
Date Range: 30/06/2019 - | to |31/07/2018 -
User ID: Mo filter -
Supervisor ID: Mo filter -
Event Type: [ New [E] Edit ] Delete [ Void |1 Unvoid || Open Cash Drawer || Delete Row
| Change Price |1 Clear Transaction || Close Counter || Row Discount [] Print || Total Discount
[ Trade In 7] Refund [ Hold Bill ] Cancel Changes [ CashIn [7] Cash Out [ Delete Hold Bill
[ Switch Cashier  [] Edit Staff Attendance ] Open Counter [ Override Point Conversion Below Min. Seling Price
Preview | Print | Open Same Document Audit Trail |

Drag a column header here to group by that column

Event Date Time User ID Terminal ID Supervisor UserID Computer Mame Event Type Description
29/07/2019 15:21 USER-PC [WE B e Tyl Sle= Below minimum selling p...
4.4 4 Record 1of 1 b bbbl 4 >
Event Message:
Below minimum selling price for ItemCode: CHEESE CREE, minimum price: €.00, current price: 5.00 -
v

Page3

Auto Count Sdn Bhd (751600-A) www.autocountsoft.com

B2-3A-01, Level 3A, Block B2, Meritus @ Oasis Corporate Park, No.2, Jalan PJU 1A/2, Ara Damansara, 47301 Petaling Jaya, Selangor Darul Ehsan.

Tel: 603-3080 8888 Fax: 603-7621 0911



Beyond accounting softwore

FnB Release Note 5.0.12.123 q ) autocount

ID: 3950 Find Item function support find Item Package Barcode
You can now search Item Package Barcode in Find Item screen.

Clear All

Item Code Jes Item Group Item Type

Description Unit Price BarCode Bal. Qty

ID: 4303 Support get E-Wallet Type from AutoCount Server

Go to Point of Sale > Maintenance > EWallet Maintenance and then press the Get EWallet Type button from the
screen, system will get the latest EWallet type that support by our POS System.

Note: Internet access is required in order to get data from AutoCount Server.

& Ewallet Maintenance - POS TESTING BACKEND - AutoCount POS (Ver: 5.0) (Rev: 123) - = x

File G/L A/R A/P Inquiry Stock Sales Purchase BonusPoint Barcode Management Plug-Ins Point of Sale General Maintenance Tools Tax Window Help

Hint: You can create and maintain EWallet here.

-EB+ New ‘/\‘\? Edit ‘ x Delete &Reﬁesh ‘ i Get EWallet Type
Drag a column header here to group by that column
Ewallet ID 4 | Description Ewallet Type Active
> ALIPAY :
ALIPAYZ ALIPAYZ Alipay
| |eoosT BOOST Boost
| |eoosT2 BOOST2 Boost
| | maveaNKaR MAYBANK QR Maybank
B ™G ™G TouchAndGo
| | ez G2 TouchAndGo
|| wecHaT WECHAT WeChatPay

Auto Count Sdn Bhd (751600-A) www.autocountsoft.com
B2-3A-01, Level 3A, Block B2, Meritus @ Oasis Corporate Park, No.2, Jalan PJU 1A/2, Ara Damansara, 47301 Petaling Jaya, Selangor Darul Ehsan.
Tel: 603-3080 8888 Fax: 603-7621 0911

Page4‘



EnB Release Note 5.0.12.123 d )autocoun’r”

Beyond accounting softwore

After you press the Get EWallet Type, you will found all the latest available EWallet type listed and you are allow
to choose and maintain them.

& New Ewallet x

EWallet 1D = Active
Description :

Ewallet Type:

Payment Method :

Wendor Charges :

Touch And Go Cancel
WeChatPay (MYR)
WeChatPay (CNY)

ID: 4174 POS Audit Trial support Refund / Trade In event
POS Audit Trial report is now support audit trial for Trade In and Refund.
You can find POS Audit Trial report under Point of Sale > Miscellaneous Reports > POS Audit Trial.

2 pos Audit Trail - POS TESTING BACKEND - AutoCount POS (Ver: 5.0) (Rev: 123) - =X

File G/L A/R A/P Inquiry Stock Sales Purchase BonusPoint Barcode Management Plug-Ins Pointof Sale General Maintenance Tools Tax Window Help | Report

w

Keyword Search | | Clear Search | ‘ Close
Search Criteria
Description Event Message [] Computer Name
Filter Options
Date Range: 30/06/2015 - to |31/07/2019 -
User ID: Mo filter M
Supervisor ID: Mo filter -
Event Type: [] New 7] Edit | Delete ] Void [ Unvoid || Open Cash Drawer  [7] Delete Row
[] Change Price [] Clear Transaction [] Close Counter [ Row Discount [ Print [7] Total Discount
—
Trade In Refund I [™] Hold Bill |7l Cancel Changes || Cash In || Cash Out [7] Delete Hold Bill
—
|1 Switch Cashier ] Edit Staff Attendance [] Open Counter [ Override Point Conversion [ Below Min. Seling Price
Preview | Print | Open Same Document Audit Trail |

Drag a column header here to group by that column

Event Date Time | User ID ‘ Terminal ID | Supervisor UserID | Computer Name | Event Type | Description | |
26/07/2012 17:37 ADMIM TFNE Tradeln Trade In at TFNB-000044 <

M 4 4 Record 7of10 b MM

Event Message:

Refund for Item Code CHICEEN CHOP
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ID: 4374 Support auto create front-end database and sync for standalone FnB
For standalone FNB system, after you done setup back-end database, system are now able to create new front-
end database and perform full sync for you automatically.

You can find this function under Point of Sale > FnB Front-End.

Point of Sale General Maintenance

Maintenance [

Promuoter 3

Cash and Receipt Reports »

Sales Reports 3
Management Reports 4
Miscellaneous Reports r
POS Setting
POS Posting

POS Transactions Viewer

Purge Pos Transaction

HQ Authorize
Import From Excel 4
Tools 3

POS Front-End

FnB Front-End

System will then prompt confirmation message, press Yes and follow the steps and then system will create the
front-end database for you and perform full sync as well.

AutoCount POS X

Note: If you already created front-end database, then system will open up the front-end FnB system for you
instead of asking you to create new database again.
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ID: 4131 Support Clerk Menu function
You can now find the Clerk Menu function in login screen. This function mainly for your clerks views report.
Other than view report, you also can perform sync over here.

Key in password and then press on Clerk Menu button from login screen.

i—A—A—A—A-I

aoo-—
B -

Bl
——

Clerk Menu taay ~ Keyboard .
19

After that Clerk Menu screen will prompt, so that user doesn’t have to login into front-end system in order to

Enter

view the reports.

Clerk Menu
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ID: 4297 Add EWallet Transaction ID column in EWallet Report
EWallet Transaction ID is now added into EWallet Report in back-end and front-end as well as report design.

2 Ewallet Report - POS TESTING BACKEND - AutoCount POS (Ver: 5.0) (Rev: 123) - = x

File G/L A/R A/P Inquiry Stock Sales Purchase BonusPoint Barcode Management Plug-Ins Pointof Sale General Maintenance Tools Tax Window Help | Report

W

Filter Options Report Option

Date Range: |03/04/2019 00:00:00 % | to |03/03/2019 23:53:59 % SortBy: |Document Number -
Cashier: Show Criteria In Report
Terminal:

outes

cvle

Cancelled Status:

Sales Type: Cash Salef Credit Sales  [] Sales Order

i;' Inguiry

= P

Preview Hme Criteria Close
Options

Drag a column header here to group by that column

Payment Time EWallet ID | Description | Fayment ... |Date Time DocMo & | Sales Type | Total (ex) | TAX Rounding Adj. Final Total

0.05 (07/08/2019 11:...

Tniz Tniz 0.05 07/08/2019 11:... TP1-000... C/S 0.05 0.00 0.05 0.00 0.04

TFNB-00... | Cft 0f | T192943145300

T192942550300
03/05/2019 12:1... TnG nG 0.05 08/05/2019 12:... TPI-000... C/S 0.05 0,00 0.05 0,00 0,08 T185370546400
29/05/2019 11:1... TnG NG 0.05 29/05/2019 11:... TPI-000... C/S 0.05 0,00 0.05 0,00 0,08 T187375095000

T194656319300

30/08/2019 11:5... MAYBAN... MAYBAN... 0.05 30/08/2019 11:... TPI-19-.. C/S 0.05 0.00 0.05 0.00 0.03

Ewallet Trans. ID

0.25| | 0.25” 0.00” 0.25” 0.00” 0.25

4 # 4 Record 1of5 b WM 4

/& putoCount Report Designer - EWallet Report (Report Type: EWallet

File Edit View Format Window

B4 EM R H§|Tahoma -|[g.25 -]
AL QNI R 1 O = O S

Field List

Creation Time
--3b| Debtor Account Mo.
Description

@ Document Key
Document Mo.

¥ [F] HeaderBand1 [¢

-[b] Indusive Tax? Payment D:

-[3k] Is Active? (True or F
-{ab | Member Name —
Member No ¥ = GroupHeaderl

.fT3] Net Total Amount ™ @ DetailBand!
] . ([PaymentTim

B B O F e[ [

v @ F{éportFooter ]

3
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ID: 3839 Auto Prompt function support prompt Description

Added “Description” into Auto Prompt function. So when users add in item in front-end, it will auto prompt Set
Description box.

You can find Auto Prompt function under Point of Sale > Maintenance > Auto Prompt Maintenance.

&5 New Auto Prompt Sequence Bx

Auto Prompt ID : l:l
Auto Prompt Type : | Apply To All Items -

[#] Enable
Tick  [Option L]
|| Qty F
LIOM
EDescripﬁon I El
w

Item Code and UCM to apply Auto Prompt option
o =g

ID: 4310 Enhanced Customer Info prompts before payment
Customer Info now will prompt before payment screen. Old version will always prompt payment screen first
then only prompt user to key in customer info.

Total :

i
Payme! Amount Edit Delete IIIIIIIIIIIIIIIEI!II

m——
pEn -
K
%[

Cash

Customer ¥
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ID: 3765 LCD Customer Display supports show Modifier, Item Package and Set Meal detail
LCD Customer Display is now able to display item’s modifier and also item package and set meal’s detail item.

Total: 545.15

Jescription
RROT JUICE

LUNCH SET1 @% mﬁ]
Description Uom
CHICKEN CHOP UNIT 15.00
ORANGE JUICE UNIT 7.90
Mo Ice
WATERMELON JUICE UNIT 7.90
Mo Sugar, Le:

CHOCOLATE CAKE UNIT 6.90
MUSHROOM SAUCE UNIT 0.00

PACKAGE A 450.00

ltem;Rackage
Uom
SHAM UNIT 100.00
HAIR CARE ESSENCE A UNIT 200.00
HAIR CONDITIONER A UNIT 150.00

ID: 4535 Add “Clean Old ChangelLog” function
Added “Clean Old Changelog” function in back-end Point of Sale > Tools > SQL Database Maintenance. This
function allow user to delete those unused data in changelog table in order to reduce the database size.

& 5L Database Maintenance

Current Database Information

Database Name: AED_POS5_BE
Database Size: 1103.25 MB

Unallocated Space:  8.48 MB

Intelligent Rebuild Index

Intelligent Rebuild Indexwill baseon the percentage of fragmentation of Indexto
determine whetherit need torebuild, rearganize, ordo nothing toall indexes, After
this operation,the performance of query may improve alot.

Shrink Database

Shrink Databasewill shrinkthe size of currentd atabase to make the databasefile size
smaller. It may take longertimeto performthis aperation. (Hint: Do not run Shrink
Databasetoofrequent, because itmay not always shrinkthe database.)

I Clean Old Changelog I

| Start |
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ID: 4458 Support “Multi Pricing” for front-end member
Added “Multi Pricing” at New Member and Edit Member screen. You can now set the multi pricing for each
member, different outlet can have different pricing for same member.

widiu rive

Multi Price
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ID: 4041 Support download sample account book during create new back-end account book
We had created 3 different types of sample FnB account book that allowed you to download and restore. Which
are Bubble Tea, Chinese Restaurant and Western Café.

You can download it from back-end File > Manage Account Book > Install Sample Account Book > Download and

install form the Web.

< Choose a Sample Account Book x

Address: | http://autocountweb. doudapp. net/products/ac_pos/program_content/SamplePosDatabase. html |5 |

AutoCount POS Backend Sample
Database

Bubble Tea

This sample database is suitable for Bubble Tea business.

.E Chinese Restaurant

This sample database is suitable for Chinese Restaurant business.

.E Western Cafe
This sample database is suitable for Western Cafe business.

Done
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ID: 4453 Support load image from Stock Item Maintenance when add in new Fast Selection

Menu ltems
If you had maintained your item’s image under Stock [tem Maintenance, now when you add the item into Fast
Selection Menu, the item’s image will be loaded automatically as well.

2 view Stock Item - [RED VELVET] - O x

Edit Copyltem Window

Item Analysis Code -
Ttem Code | RED VELVET Ttem Group | CAKE

Description RED VELVET Ttem Type | TYFEA
Ttem Brand
Total Balance Qty 0 Lead Time Duty Rate (%) 0 Ttem Category
Supply Tax Code Purchase Tax Code Ttem Class

Tariff Code
Costing Method |Weighted Average Main Supplier Stock Control || Controlled by Batch No || Cont

Calculate Bonus Point

| Details [ 1tem Batch | Replacement Item | Image || Further Description || External Link || Note || FnB

Size mode: |Squeeze Alignment: | Top Left

4| [ ] »

|ilL|Lli| ‘ Edit || Deactivate || Delete || Close

B - R ox
Load |Item - ‘ Add Menu ‘ ‘ Range Set ‘

Item Group o fiter -

ltem Type o fiter . ‘ Check all ‘ ‘ Uncheck Al ‘ ‘ Search ‘

— UOM | Descript Ite... U... |Descri.. [S...[Fee [Foe [P B L | ke
|ro.u. cHEESE..Ss. 9 7 H.B. =

|| POWERBA... BOX  POWER~ ?---D U CHOCOL...S.. 9 © M. Br.. = gl

|| POWERBA... UNIT  POWER DURIAN... S.. 9 O HM.Br.. =

B POWERBA... UNIT  POWER HZ!I___I:-EHQB | po ] |
POWERBA... UNIT  POWER

!
S001 UNIT 5001

SALTED E... UNIT SALTEL
SERIAL NO  UOM SERIAL
SHAMPOO A UNIT SHAMP
SHAMPOO B UNIT SHAMP
STAR FRU... UNIT STARF
TEH TARIK  UNIT TEHTE

L
e

oK H Cancel |

B TEST CTN  TEST @
B TEST UNIT  TEST Down
TEST2 BO)( TEST2

=
ID00 000000000000 R

ohec . TEeTY b

M 4 Record 4?oF62 oA ||||

oK ‘ ‘ Cancel ‘
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ID: 4413 Support fingerprint at supervisor bypass screen
Fingerprint is now available to be used at every supervisor bypass screen. What you have to do is just place your
registered finger on the fingerprint device will do. Then system will check whether you have the access right to

bypass current process or not.

Note: Fingerprint device must be installed and user’s fingerprint must be maintained at back-end Point of Sale >
Maintenance > POS User Maintenance.

= Edit POS User = -
UserID : | ADMIN | [ Active V] Is Cashier
Manage
Name : | Administrator Fingerprint
Phaone Mo. : | |
Teamorsils | e —— |
Confirm Password: | FEEEEEREES |
User Group : |Administrators - |
Outlet : HQ -
Default Promoter : | *|
Mote :
s o B 7 U|EEE|EEE |4y
-
ok | | cancel
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ID: 4672 Support loads multiple item group and item type in Kitchen Printer Maintenance
You are now able to add in multiple Item Groups and Item Types in Kitchen Printer Maintenance, no more need
to add in all of them one by one.

You can access this function at back-end Point of Sale > Maintenance > Kitchen Printer Maintenance.

Press the magnifier icon.

L',’f Item Printer Set Maintenance x
Printer Set ID: 1 Is Active?
Description: |1 [C1 Each Record Per Receipt

[ Separate Qty

m Item Group || Item Type

Drag a column header here to group by that column
Item Group Description
| ] CAKE CAKE
B FOOD FOOD
B OTHER OTHER
| ] SALICE SAUCE
44 44 4 Record 1of 5 b M M 4 »

| oK | | Cancel |

The Multi-Select screen will prompt out. You can tick multiple records here or press Select All and then press OK

button to add them in.

2 Mult-Select Stock Ttem Group =0
Drag a column header here to group by that column
Check Item Group Description
» 0
CAKE CAKE
FOOD FOOD
= OTHER. OTHER.
= SALICE SALICE
| selectAl || Unselectll | Filter Show All items ~| 0 selected ok | | cancel
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ID: 4645 Support Sales Credit Note in Remote HQ Function
Sales credit note are now available in Remote HQ function. You can access this function at front-end More
Function > Inquiry > Remote HQ.

Note: Remote HQ module have to be purchased in order to use this function.

AED_POS5_BE

Purchase

Stock Al

Sales
- m—— -
e e 0 Quotation
aintenance R mintenance B
[l m— ]
d _redito
L

15
]
aintenance ] i B
]
]
]

L

; .
g
]

Quotation

chase Orde|

i

ifi
HHEHE
il

n [
=T EL
— [

2rming .
aintenance ] B
— [

Uption o] 5.
=T mL
Promoti B Serial Numb
aintenance ] ransaction

M

t

FFAFlFaFa T

oucher |l
aintenance B

Stock Statu

Report

[ o (MmN [Naew [Nace i

H ?

Worksheet

ID: 4679 Add in “Table No.” column in Kitchen Printer Log screen
We had added in “Table No.” column in the Kitchen Printer Log screen. You can access Kitchen Printer Log
feature in front-end More Function > Inquiry > Kitchen Printer Log.

Printe... TableNo Doc No. Print Date Print By Is Print...

s & 01 [lrFnB-HB-19-000063 | 06/09/2019 05:43 PM | ADMIN
04 06,09, 4 =

E PO 14 IFNB-HB-19-000064 9 05:49 PM  ADMIN
H POS-80.. 06 FMB-HB-19-000065 0 (2019 05:49 PM  ADMIN E
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ID: 2650 Support Auto UOM Conversion
Auto UOM Conversion is now available in this version. Auto UOM Conversion feature will help you to convert
the item UOM from available quantity UOM to backordered quantity UOM.

E.g.:- You have 1 item code TUPPERWARE with 2 UOM which is PCS and BOX.

Item Code UoM Rate Original Balance Qty
TUPPERWARE PCS 1 3
BOX 12 5

From above scenario, if you create a new transaction that selling quantity of 5 PCS TUPPERWARE in front-end,
after sync then back-end will create a Stock UOM Conversion document and convert 1 BOX TUPPERWARE to 12
PCS TUPPERWARE.

So, after Stock UOM Conversion created your latest balance quantity for TUPPERWARE will be 10 PCS and 4 BOX.

Item Code UOM Rate Latest Balance Qty
TUPPERWARE PCS 1 10
BOX 12 4

In order to use this feature, you will need to fulfill the requirements as below:

Must have Advanced Multi-UOM module in back-end.
Must have POS Advanced Multi-UOM module in back-end.
Must enable Auto UOM Conversion option in Stock Item Maintenance.

I

Must restart server Sync Monitor after you done the settings above.

Example of Stock UOM Conversion document created automatically based on front-end transaction as below.

— — — —— B =
’ L'.,\l View Stock UOM Conversion - [UOM-000010] - POS TESTING BACKEND - AutoCount POS (Ver: 5.0) El_‘g
A

ﬂQ,,J Hame Edit
: : ) e
@ = /%'\' :‘1‘; x (4 4> M Eﬂ ucl

Preview Print Edit Void Delete Copy from other Copy to a new Stock
Stock UOM Conversion  UOM Conversion

Copy Stodk UOM Conversion

View

Document Mavigation

This document is created by OS[TPJ-19-000035]

| »

0ol o Wl JOM Conversion Generated From TPJ-19-000035 Stock UOM Conversion Mo | UOM-000010
Date | 29/08/2019 -
Item Code | Description | Location | Batch Na. | Proj. No. | Dept. Mo. | From Qty From UOM | To UOM | To Qty |
% | TUPPERWARE TUPPERWARE Pl 1 m PCS 12

i # 4 Fecord 1of1 b B M

4
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Must enable Automatic UOM Conversion option at back-end Tools > Options > Invoicing > Document Control.
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ID: 4524 Upgrade .Net Framework from 4.5 to 4.6.1
We upgraded Microsoft .Net Framework from version 4.5 to 4.6.1. Please make sure your device / computer
does support .Net Framework 4.6.1 or above.

Minimum supported operating system is Windows 7 Service Pack 1 (SP1).

Microsoft

NET
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